
 

 

 

 

Smartsite iXperion 1.3 

Installatie Cursus 

 

Windows 2008 R1 32 Bit 

 

 

 

 
Copyright © 2010 - 2011 

  



 

Inhoudsopgave 

1 Inleiding .............................................................................................................................................. 3 
1.1 Smartsite iXperion installatiehandleiding– Windows 2008 R2  64 Bit ..................................... 3 

2 Smartsite iXperion 1.3 DVD Content ................................................................................................ 4 
3 Smartsite iXperion site ...................................................................................................................... 6 

3.1 Database Server .................................................................................................................... 7 
3.2 File Server .............................................................................................................................. 7 
3.3 CMS Server ............................................................................................................................ 7 
3.4 Publicatie Server .................................................................................................................... 7 
3.5 IIS Web Server ....................................................................................................................... 7 
3.6 Developer Console (TestSuite) .............................................................................................. 7 
3.7 StateSyncService ................................................................................................................... 8 
3.8 InteropService ........................................................................................................................ 8 
3.9 EventSynchronizationService (TestSuite publicatie state service) ......................................... 9 
3.10 cmsWebService (TestSuite CMS state service) ..................................................................... 9 
3.11 SchemaService ...................................................................................................................... 9 

4 Hardware en Software support ...................................................................................................... 10 
4.1 Inleiding ................................................................................................................................ 10 
4.2 minimum eisen ..................................................................................................................... 10 

4.2.1 Smartsite Server software ......................................................................................... 10 
4.3 Database software ............................................................................................................... 10 

4.3.1 Microsoft® SQL Server Express ................................................................................ 10 
4.4 Smartsite iXperion server hardware vereisten ...................................................................... 11 

4.4.1 Server hardware / vmware instantie .......................................................................... 11 
4.5 SQL Database Server inrichting ........................................................................................... 11 
4.6 Processoren ......................................................................................................................... 11 
4.7 Ram geheugen benodigd ..................................................................................................... 11 
4.8 Minimale hoeveelheid geheugen per query .......................................................................... 12 
4.9 Full-Text Search ................................................................................................................... 12 
4.10 Documenten doorzoeken met Full-Text Search ................................................................... 13 
4.11 Smartsite iXperion vereiste componenten ............................................................................ 13 
4.12 Development omgeving ........................................................................................................ 13 
4.13 VMWare ............................................................................................................................... 13 

5 Installatie Smartsite iXperion 1.3 (Windows 2008) ....................................................................... 14 
Controleren Windows Systeem (Pre-requisites)............................................................................... 14 

6 Required Components .................................................................................................................... 26 
7 Smartsite Setups ............................................................................................................................. 38 

7.1 Smartsite iXperion CMS Setup ............................................................................................. 38 
7.2 Smartsite iXperion Publication Installatie ............................................................................. 41 

7.2.1 Publication Update setup ........................................................................................... 52 
8 IIS 7 HTTP Server configuratie ....................................................................................................... 55 
9 Windows Accounts en Folder Permissions .................................................................................. 65 

Windows Accounts ........................................................................................................................... 65 



 

10 Smartsite iXperion Licentie ............................................................................................................ 67 
11 Internet Explorer Temporary Internet Files directory ................................................................... 68 
12 Smartsite iXperion Config Editor ................................................................................................... 72 
13 Config Editor foutmeldingen en oplossingen ............................................................................... 83 
14 Validate Operational Status ............................................................................................................ 92 
15 System Panel ................................................................................................................................. 102 
16 Internet Explorer Security Zones ................................................................................................. 103 
17 Headermappings ........................................................................................................................... 105 

17.1 Site Smartsite.Config .......................................................................................................... 105 
17.2 SMTP Server in de Smartsite.config .................................................................................. 106 
17.3 IIS Bindings ........................................................................................................................ 107 
17.4 Site Registry ....................................................................................................................... 108 

18 StateSyncService .......................................................................................................................... 109 
19 Performance library errors voorkomen ....................................................................................... 111 
20 Klaar ............................................................................................................................................... 111 
21 Performance Counters .................................................................................................................. 112 
22 SXML Editor ................................................................................................................................... 114 
 

 

 

 

1 Inleiding 

Deze Smartsite iXperion installatiehandleiding beschrijft de standaard “Clean Install” installatie van iXperion 1.3 

op een Windows 2008  R1 32 Bit server systeem met SQL server 2005 als database server. 

 

1.1 Smartsite iXperion installatiehandleiding– Windows 2008 R2  64 Bit 

 

Naast deze installatie handleiding voor Windows 2008 R1 32 bit systemen is er tevens een iets aangepaste 

versie voor de installatie op Windows 2008 R2 64 bit systemen te verkrijgen. 

 

 

 

  



 

2 Smartsite iXperion 1.3 DVD Content 

De Smartsite iXperion 1.3 Setup DVD bevat de volgende directory structuur 

 

In de root van de DVD-rom  vind je de volgende twee bestanden: 

 



 

 DVD Contents.html 

 

Dit document geeft een beknopt overzicht van de DVD content. 

Daarnaast wordt verwezen naar: 

o Fixes and New Features / list of the changes 

Een overzicht met alle aanpassingen t.o.v. de vorige versies 

o Known issues 

Een overzicht met nog bekende problemen 

o http://ixperion.smartsite.nl 

De Smartsite iXperion Informatie site. Wanneer je hiervoor nog geen inlog hebt kun je 

deze aanvragen via office@smartsite.nl 

 

 Installation Documentation Smartsite iXperion 1.3.mht 

 

Wanneer je al veel ervaring hebt met: 

o De installatie van eerdere Smartsite versies 

o IIS configuratie 

o SQL Database Server Configuratie 

o Webservices 

o Etc. 

 

Dan kun je de bijgeleverde beknopte installatie handleiding stap voor stap volgen. 

 

 

 

mailto:office@smartsite.nl


 

3 Smartsite iXperion site 

Hieronder worden kort de onderdelen besproken waaruit een Smartsite iXperion site is opgebouwd. 

 

Smartsite iXperion bestaat uit 3 componenten:  

 De iXperion Publicatie Server 
Dit is de in Microsoft .Net site publicatie omgeving (.aspx)  

 De iXperion CMS Server 

Dit is net als in Smartsite 5 de zogeheten Smartsite Manager voor het toevoegen van items. 
Deze applicatie is nog steeds geschreven in Visual Basic 6 (32 bits) . 

 Smartsite TestSuite 
Dit is een clientside tool die gebruikt wordt tijdens de ontwikkeling van de site. De TestSuite 
verzorgt zijn eigen publicatie server, echter voor het opslaan van items in de database is nog 
steeds de CMS server vereist. 

Een Smartsite iXperion site bestaat uit een collectie van servers en WCF services. De WCF Services worden 

gebruikt voor de communicatie tussen deze servers. 

 

 

 

 

 

 

 

 

 

 

 



 

Servers 

3.1 Database Server 

 

De database server wordt gebruikt om alle content op te slaan. 

Momenteel worden de volgende database services ondersteund: 

 

 SQL Server 2005 en 2008 

 Oracle 10g en 11g  

3.2 File Server 

 

Hoewel Smartsite iXperion bijna alle gegevens kan opslaan in de database, kunnen bestanden zoals plaatjes,  

CSS en Javascripts ook op disk worden opgeslagen. 

3.3 CMS Server 

 

De CMS server wordt gebruikt om de content in de database en op het file systeem te bewerken. (Redacteuren 

in manager). De CMS server is in principe gelijk aan de versie van de Smartsite 5 manager. 

In veel gevallen wordt de CMS server ook als File Server gebruikt. 

3.4 Publicatie Server 

 

De publicatie server wordt gebruikt voor de weergave van de content. In Smartsite iXperion is deze publicatie 

server nu gebaseerd op het Microsoft .Net platform (ASP.NET) 

3.5 IIS Web Server 

 

Net als in Smartsite 5 en lager draait iXperion onder de Webserver IIS. Zowel de CMS als de Publicatie server 

maken gebruik van de IIS Webserver. Windows 2008 komt met IIS 7.0. 

3.6 Developer Console (TestSuite) 

 

Om het ontwikkelingswerk van developers te verrijken met meer functionaliteiten is er tevens een developer 

.NET native client applicatie ontworpen. Deze client kan lokaal geïnstalleerd worden en verbinding maken met 

de Publicatie en/of CMS instantie. 

 

 



 

Services 

De communicatie tussen de servers verloopt via Microsoft Windows Communication Foundation (WCF).  

WCF is de nieuwe manier om een gedistribueerde applicatie te maken in .NET. Waar je voorheen moest kiezen 

uit een aantal compleet andere technieken, zoals webservices en .NET remoting, biedt WCF je de voordelen 

van al die technieken bij elkaar. 

 

 

 

 

3.7 StateSyncService 

The StateSyncService synchroniseert de state tussen de CMS Server en de Publicatie Server.  

Omdat het CMS proces in een andere “memory space” draait dan de Publicatie server, moet bijvoorbeeld bij 

het toevoegen van een item op de CMS server, de publicatie server ook op de hoogte worden gesteld dat er 

een nieuw item is toegevoegd. 

 

3.8 InteropService 

 

De InteropService zorgt voor de interactie tussen de CMS server en de Publicatie server. Wanneer je 

bijvoorbeeld een preview doet via de manager van de CMS server, dan moet dat item “gerenderd” worden door 

de publicatie server en terug worden gegeven aan de CMS server. 

 

 

 

 



 

3.9 EventSynchronizationService (TestSuite publicatie state service) 

 

De EventSynchronizationService wordt gebruikt in de connectie met de client TestSuite. Wanneer deze 

connectie heeft met de Publicatie Server, dan wordt de state van de developer tool automatisch geupdate door 

de eventSynchronizationService wanneer de state van de Publicatie Server verandert. 

 

3.10 cmsWebService (TestSuite CMS state service) 

 

De cmsWebService wordt gestart door de CMS Server. 

 

Hieronder de volgorde waarin de services afgaan wanneer een item wordt toegevoegd in de TestSuite Console: 

 

1. Item toevoegen in Developer TestSuite console  

2. cmsWebSercvice update de state van de CMS Server 

3. De Publicatie Server wordt hier opeenvolgend bijgewerkt via de StateSyncService. 

4. De Publicatie Server zal op zijn beurt alle actieve Developer Test Suite Console update via de 

EventSynchronizationService. 

 

3.11 SchemaService 

 

De SchemaService wordt gebruikt om de juiste SXML Schemas op te halen wanneer men gebruik maakt van 

de Smartsite SXML Editor ActiveX control. Denk aan code-completion, intellisense en validation. 

Wanneer de Publicatie Server start worden alle schema’s omtrent macros en vipers informatie aangemaakt. De 

SchemaService wordt gebruikt voor het aanleveren van deze informatie aan de SXML editor wanneer deze 

binnen edit item wordt gebruikt. 

 



 

4 Hardware en Software support 

4.1 Inleiding 

De laatste minimale hardware en software eisen voor Smartsite iXperion staan beschreven in het document 

“Smartsite iXperion Requirements - vX.X” welke voor de installatie aan de klant wordt toegestuurd. 

 

Hieronder worden de minimale hardware en software eisen vermeld voor een Smartsite iXperion 1.3 en hoger 

server systeem. Daarnaast worden de minimale specificatie voor de SQL database server vermeld. 

 

 Let op: Smartsite iXperion 1.2 en lager ondersteunt alleen 32 bit Windows 2003/2008 systemen. 

 Let op: Smartsite iXperion 1.3 en hoger ondersteunt 32 en 64 bit Windows 2003/2008 Windows systemen. 

4.2 minimum eisen 

De hier genoemde eisen zijn de minimum eisen voor een Smartsite iXperion 1.3 en hoger omgeving. 

4.2.1 Smartsite Server software 

Smartsite iXperion 

Microsoft® Windows Server 2003 met IIS 6 

Microsoft® Windows Server 2008 met IIS 7 

Microsoft® Windows Web Server 2008 met IIS 7 

Voor alle systemen geldt: 

 Ondersteuning van R1/R2 en 32/64-bit edities 

 Servers dienen via Windows update met de laatste service pack te zijn voorzien. 

4.3 Database software 

Microsoft® SQL Server 

Microsoft® SQL Server 2005 

 Standard Edition en hoger 

 Service Pack 3 en hoger 

Microsoft® SQL Server 2008 

 Standard Edition en hoger 

Met Microsoft® Windows 2003 of 2008 32 of 64 bit besturingssysteem  

 

Zie voor meer informatie over Microsoft®  SQL Server Editions  

http://www.microsoft.com/sqlserver/2008/en/us/editions.aspx    

4.3.1 Microsoft® SQL Server Express 

 

 Let op: Voor niet productieomgevingen kan men gebruik maken van de gratis versie Microsoft® SQL 

Server Express with Advanced Services. 

http://www.microsoft.com/sqlserver/2008/en/us/editions.aspx


 
Elektronicaweg 31  

2628 XG  Delft,  Nederland  
T   +31 (0)15 - 251 37 00  
F   +31 (0)15 - 251 37 01 

 

 
 

Door ing. Silvio Bosch Pagina 11 5-10-2011 

Versie 1.4 

Smartsite iXperion 1.3 Installatie Cursus – (Win 2008 R1 32 Bit) 

4.4 Smartsite iXperion server hardware vereisten 

4.4.1 Server hardware / vmware instantie 

 2  Processor P4/Xeon of hoger 

 2 GB RAM 

 Systeem disk C:\ ~50 Gb 

 Data Disk D:\ ~100 GB 

 Netwerk Interface kaart (IPv4) 

 

Indien de SQL Server database op de webserver wordt geplaats gelden de volgende minimale specificatie: 

 2  Processor P4/Xeon of  hoger 

 6 GB RAM 

 Systeem disk C:\ ~50 Gb 

 Data Disk D:\ ~100 GB 

 Netwerk Interface kaart (IPv4) 

 

VMWare: 

Wanneer gebruik wordt gemaakt van VMWare kunnen bovenstaande instellingen afwijken afhankelijk van de 

VMWare configuratie. Overleg met de infrastructuur specialist  is benodigd. 

4.5 SQL Database Server inrichting 

Smartsite iXperion legt een zware load op de SQL server. De SQL server (instance) dient daarom minimaal aan 

de door Microsoft opgelegde eisen te voldoen. Echter wordt aanbevolen ver boven deze minimale specificaties 

te gaan zitten. 

 

Voor Smartsite iXperion wordt aangeraden gebruikt te maken van een dedicated SQL server 2005 of 2008 

(aanbevolen) met onderstaande minimale specificaties:  

4.6 Processoren 

Aanbevolen wordt minimaal 2 processoren van Xeon 2.4 Ghz of hoger te gebruiken, maar het is beter 4 

processoren te gebruiken. 

4.7 Ram geheugen benodigd 

 

Aanbevolen wordt  minimaal 4 GB Ram intern geheugen toe te kennen. 

 

Wanneer SQL Server 2008 wordt gebruikt op een VMware omgeving is het aan te raden voor het Windows 

server systeem 6 Gb Ram geheugen te reserveren en de SQL server te beperken tot 4 GB Ram. 

 

Afhankelijk  of het een VMWare ESX omgeving betreft dienen de Vmware instance settings voor de SQL server 

te worden aangepast. Seneca kan hierbij adviseren. 
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4.8 Minimale hoeveelheid geheugen per query 

 

In SQL server is het tevens mogelijk het minimale geheugen per query op te geven. 

 

Standaard is dit 1024 KB per query, wat tevens voor Smartsite iXperion de minimale waarden is. 

 

Zie: http://msdn.microsoft.com/en-us/library/ms191303(v=sql.90).aspx  

4.9 Full-Text Search 

Smartiste iXperion maakt gebruik van SQL server Full-Text Search. Full-Text Search dient bij de SQL Server 

installatie te worden meegenomen in de setup. Full-Text Search wordt met name gebruikt voor Faceted Search. 

 

  Let op: Voor Microsoft® SQL Server Express geldt dat de versie met Advanced Services benodigd is.  

 

Onderstaand de links voor download: 

 

2005 

Microsoft® SQL Server® 2005 Express with Advanced Services: 

http://www.microsoft.com/downloads/en/details.aspx?familyid=4c6ba9fd-319a-4887-bc75-

3b02b5e48a40&displaylang=en  

 

Beperkingen: 

 Maximaal 1 CPU 

 Maximaal 1 GB memory voor de buffer pool 

 Maximale grootte database 4 GB 

 

2008 

Microsoft® SQL Server® 2008 Express with Advanced Services: 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b5d1b8c3-fda5-4508-b0d0-

1311d670e336&displaylang=en  

 

Beperkingen: 

Maximaal 1 CPU 

 Maximaal 1 GB memory voor de buffer pool 

 Maximale grootte database 10 GB 

 

Zie: http://www.microsoft.com/sqlserver/2008/en/us/editions.aspx  

 

   Let op: Seneca adviseert voor de productieomgeving gebruik te maken van SQL Server 2008 

standard edition of hoger (32 of 64 bit).  

http://msdn.microsoft.com/en-us/library/ms191303(v=sql.90).aspx
http://www.microsoft.com/downloads/en/details.aspx?familyid=4c6ba9fd-319a-4887-bc75-3b02b5e48a40&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?familyid=4c6ba9fd-319a-4887-bc75-3b02b5e48a40&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b5d1b8c3-fda5-4508-b0d0-1311d670e336&displaylang=en
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=b5d1b8c3-fda5-4508-b0d0-1311d670e336&displaylang=en
http://www.microsoft.com/sqlserver/2008/en/us/editions.aspx
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4.10 Documenten doorzoeken met Full-Text Search 

Om andere documenttype te indexeren en te doorzoeken met Full-Text search (Faceted Search) dient Office 

2007 iFilters en Adobe Reader® versie 9.4 of hoger te worden geïnstalleerd op de SQL server. 

 

Voor de juiste installatie procedure van de text iFilters zie: 

http://support.microsoft.com/default.aspx?scid=kb;en-us;945934  

 

of 

 

http://ixperion.smartsite.nl/Community/Sml/The_Smartlets/QuickSearch-Smartlet/WebToolkit-

Documentation/Step-3-Register-IFilters-with-SQL-Server-2005-or-SQL-Server-2008.html  

 

 Adobe® PDF iFilter 6.0 is niet geschikt voor SQL Server 2008. Staat deze al wel geïnstalleerd, de-

installeer deze dan eerst. 

 

Voor 64 bit systemen dient een apart 64 bit versie van Adobe Reader® 9  te worden gedownload: 

http://www.adobe.com/support/downloads/detail.jsp?ftpID=4025.  

 

 Let op: Wanneer Adobe Reader® wordt geupgrade naar versie 10 dan wordt het iFilter automatisch 

verwijderd! Dit is niet de bedoeling. 

4.11 Smartsite iXperion vereiste componenten 

Smartsite iXperion Vereiste Componenten 

*Internet Explorer 7 of hoger 

Microsoft Soap SDK (version 3.0 of hoger) 

MSXML 4 (Service Pack 2 of hoger) 

*MSXML 6 

*.NET 3.5 Sp1 of hoger runtime 

Microsoft SQL Server Client Tools 

 

*Standaard aanwezig op een windows 2008 server 

4.12 Development omgeving 

In de development omgeving wordt de volgende ontwikkel tool ondersteund: 

 

 Microsoft Visual Studio 2005 SP1 

 

4.13 VMWare 

Wanneer gebruik wordt gemaakt van VMWare (VMWare ESX(i) of MS Hyper-V )  kunnen bovenstaande 

instellingen afwijken afhankelijk van de VMWare configuratie. 

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;945934
http://ixperion.smartsite.nl/Community/Sml/The_Smartlets/QuickSearch-Smartlet/WebToolkit-Documentation/Step-3-Register-IFilters-with-SQL-Server-2005-or-SQL-Server-2008.html
http://ixperion.smartsite.nl/Community/Sml/The_Smartlets/QuickSearch-Smartlet/WebToolkit-Documentation/Step-3-Register-IFilters-with-SQL-Server-2005-or-SQL-Server-2008.html
http://www.adobe.com/support/downloads/detail.jsp?ftpID=4025
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5 Installatie Smartsite iXperion 1.3 (Windows 2008) 

Controleren Windows Systeem (Pre-requisites) 

 

Smartsite heeft een aantal minimale software eisen die eerst gecontroleerd dienen te worden.  

 

 Windows updates 

Wees er zeker van dat de laatste Windows updates en patches geïnstalleerd zijn. 

Het is verstandig de Windows update pas na de installatie van alle vereiste componenten (required 

components) uit te voeren. 

 

 IIS  

Controleer of  de rolen Application Server en Web Server (IIS) geïnstalleerd zijn. 

Wanneer dit niet het geval is voeg dan beiden rollen toe via de Server Manager. 

 

 Let op: Smartsite iXperion vereist bepaalde features in de IIS Setup. Een default installatie van IIS 

voldoet niet! 

 Start de Server Manager  via: 

 

Windows start menu  >  Administrative Tools > Server Manager 

 

Selecteer in het Server Manager menu de Roles views en klik in het rechter scherm op Add Roles als IIS 

nog niet als role is toegevoegd. 

 

 

 

 



 
Elektronicaweg 31  

2628 XG  Delft,  Nederland  
T   +31 (0)15 - 251 37 00  
F   +31 (0)15 - 251 37 01 

 

 
 

Door ing. Silvio Bosch Pagina 15 5-10-2011 

Versie 1.4 

Smartsite iXperion 1.3 Installatie Cursus – (Win 2008 R1 32 Bit) 

Zorg ervoor dat aan de weergegeven voorwaarden is voldaan en klik dan op Next > 
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Selecteer de Application Server en Web Server (IIS) role. 
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Lees goed de informatie over de Application Server door en klik op Next > 
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Selecteer alleen de Application Server Foundation role service en klik op Next >. 
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Lees goed de informatie over de Web Server (IIS) door en klik op Next > 
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 Let op: Omdat er in iXperion een referentie naar het ASP object zit dient ook ASP geselecteerd te 

worden.  

 

Selecteer minimaal bovenstaande role services en klik op Next > 

 

De IP en Domain Restrictions optie is benodigd om een Publicatie runtime licentie af te kunnen schermen 

voor adressen van buiten (clients). 

 

Wanneer er oudere componenten worden gebruikt die de IIS configuratie aanspreken via ADSI, dan dient 

tevens de IIS 6 Management Compatibility te worden aangevinkt. 

 Wanneer bovenstaande melding verschijnt klik dan de Add Required Role Services knop 
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Klik op Install om de installatie te starten. In tegenstelling tot Windows 2003 is hiervoor geen Windows 

installatie DVD benodigd. 
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Controleer of de installatie met succes is verlopen en sluit dan af.  De IIS role is nu zichtbaar in de Server 

Manager Tree en de Features zijn zichtbaar in het Tree Features menu. 

 

Opmerking: 

Sluit na de IIS installatie alle Server Manager management console(s) af en start deze daarna opnieuw op 

om de wijzigingen zichtbaar te maken. 
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 Internet Explorer Enhanced Security Configuration 

 

Controleer dat Internet Explorer Enhanced Security Configuration niet geselecteerd is. Start daarvoor 

de Server Manager en selecteer de root in de Tree. 

 

Selecteer vervolgens Configure IE ESC 
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Selecteer voor zowel de Administrator als Users de Off optie. 

 

 Let op: Wanneer Enhanced Security Configuration wel geconfigureerd is, zal bij het opslaan van 

een rendertemplate of translatie de site in een deadlock kunnen geraken.  
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6 Required Components  

Op de DVD staan in de directory  “Setup\Required Components” de benodigde software componenten die 

Smartsite iXperion gebruikt.  Installeer de componenten in onderstaande volgorde. 

 

 Let op: afhankelijk van de Windows Updates die al zijn uitgevoerd op het  systeem kunnen de 

componenten al aanwezig zijn. 

 

Setup\Required Components\Microsoft Soap SDK\SoapSDK.exe 

 

De SOAP SDK Toolkit wordt door Smartsite iXperion gebruikt voor Outscaling. 

 

Installeer  de Microsoft SOAPSDK Toolkit 3.0. Maak alle niet te gebruiken features niet beschikbaar. 
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Klik op Install en wacht tot de installatie compleet is. Herstarten van de server is niet nodig. 
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MSXML 4 SP2 en MSXML 6 

 

Via de Add or Remove Programs dialoog kun je nagaan of de genoemde MSXML versies al geïnstalleerd zijn. 

Is dit niet het geval voer dan de setups uit. 

 

MSXML 4 SP2 

Setup\Required Components\MSXML\MSXML 4 Service pack 2\msxml.msi 

 

 

In de MSXML 4.0 setup klik op Install Now. 
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MSXML 6 (niet installeren) 

 

Setup\Required Components\MSXML\MSXML 6\msxml6_x86.msi 

 

Standaard is MSXML 6 sp2 al geïnstalleerd op een Windows 2008 systeem. Deze setup hoeft dus niet te 

worden uitgevoerd. Wordt de setup wel uitgevoerd dan zal de volgende melding verschijnen. 
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Microsoft SQL Server Client Tools 

 

Om de publication setup / update scripts of de database creation scripts te kunnen uitvoeren zijn de Microsoft 

SQL Server Client Tools benodigd. 

 

Deze zijn terug te vinden in de folder: “Setup\Required Components\Microsoft SQL Server Client Tools” 

 

Het is belangrijk om eerst de Native Client te installeren, omdat deze nodig is om de Command Line Utils te 

installeren.  

 

   Let op:  installeer de 32 bit versie >  sqlncli.msi 
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Klik Next >  

 

Hierna is het mogelijk om de SQL Command Line Utils te installeren 

 

 Let op:  installeer de 32 bit versie > SqlCmdLnUtils.msi 
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Na het installeren van de Microsoft SQL Server Client Tools is het belangrijk dat het installatie path wordt 

toegevoegd aan de PATH variabele van de System Environment Variables: 

 

 “C:\Program Files\Microsoft SQL Server\100\Tools\Binn” 

 

 Via het Windows start menu kies: Control Panel > System 

 Klik op Advanced system settings 

 Op de Advanced tab klik op de knop Environment Variables 

 Bewerk de PATH variabele en voeg daar (puntkomma gescheiden) het volgende path aan toe: 

C:\Program Files\Microsoft SQL Server\100\Tools\Binn\ 
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.Net 3.0 Runtime (niet installeren) 

 

Ook .Net 3.0 (onderdeel van de .Net 3.5 setup) is al geïnstalleerd en is aanwezig als Features bij de Web 

Server  (IIS) Role installatie. 

 

Om snel na te gaan welke .Net versies er geïnstalleerd zijn op het systeem kun je de directory 

C:\WINDOWS\Microsoft.NET\Framework64 openen. Hier staan alle versies die geïnstalleerd zijn weergegeven. 

 

 

 

 Let op: Versie 3.0, 3.5 zijn Add-ons op versie 2.0.50727. In IIS kun je dus kiezen voor versie 2.0.50727 of  

indien aanwezig een oudere of nieuwere geregistreerde .Net versie zoals versie v4.0.30319. 

 

Wanneer je de setup toch uitvoert krijg je onderstaande melding: 
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 Let op: Op 32 bit systemen is.Net 2.0 service pack 2 is vereist. De site zal niet starten als .Net service 

pack 2 niet geïnstalleerd is.  

 

De volgende fout wordt gelogd in de Windows Application Eventlog: 

An unhandled exception occurred and the process was terminated. 

 

Application ID: /LM/W3SVC/2/ROOT 

 

Process ID: 3728 

 

Exception: System.MissingMethodException 

 

Message: Method not found: 'Boolean System.Threading.WaitHandle.WaitOne(Int32)'. 

 

StackTrace:    at Smartsite.Core.Site.<Open>b__0() 

   at System.Threading.ThreadHelper.ThreadStart_Context(Object state) 

   at System.Threading.ExecutionContext.Run(ExecutionContext executionContext, 

ContextCallback callback, Object state) 

   at System.Threading.ThreadHelper.ThreadStart() 

 

De juiste versie kun je controleren via de registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Framework Setup\NDP\v2.0.50727 

 

Voer een Windows update uit  (zie hierna).  

 

Internet Explorer 7 en 8 

 

Standaard wordt een Windows 2008 systeem voorzien van Internet Explorer 7.  Via Windows update  wordt IE 

8 geïnstalleerd.  
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Microsoft  Windows Update 

 

Na het uitvoeren van alle required component setups is het aan te raden een Windows Update uit te voeren.  

Via het Windows Start menu kies > Windows Update 

 

 

Selecteer Install Updates. Hierna zal in veel gevallen de computer vragen om een herstarten. 
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User Account Control 

 

I.v.m. registry Virtualization dienen we UAC (User Account Control) op de server uit te zetten. Dit doen we door 

de volgende stappen te volgen: 

 

- Ga naar Start -> Run en typ msconfig 

- Op het Tools tabblad selecteer je Change UAC Settings 

- Klik op Launch. 

- Herstart de machine. 
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7 Smartsite Setups 

Nu het Windows systeem compleet is, kunnen we starten met de installatie van de Smartsite componenten.  

De volgende Smartsite iXperion componenten dienen te worden geïnstalleerd. 

 

 Smartsite iXperion CMS Setup 

 Smartsite iXperion Publication Installatie 

 Smartsite iXperion Config Editor 

7.1 Smartsite iXperion CMS Setup 

De Smartsite CMS setup installeert alle gedeelde componenten die benodigd zijn om de Smartsite Manager 

website te kunnen tonen en bedienen
1
. 

 

Omdat dit een eerste installatie is zullen er nog geen Smartsite componenten zijn die in IIS draaien. Toch is het 

een goede gewoonte eerst IIS te stoppen voordat je Smartsite gaat installeren of updaten. 

 

Stop IIS 

 

 Klik op Start 

 Klik op Run 

 Typ cmd en klik OK 

 Op de command prompt, typ het volgende commando, en druk op ENTER. 

 

IISReset /stop  

 

Om IIS weer te starten kun je de volgende commando’s gebruiken 

 

IISReset 

 

Of  

 

IISReset  /start 

 

Installeer de Smartsite CMS componenten door de setup  SmartsiteCMS_Setup_x.x.exe In de Setup\CMS 

Setup directory uit te voeren. 

 

 

 Let op: Het is niet mogelijk het installatie pad te wijzigen. Smartsite iXperion zal daarom altijd op de  

C:\ schijf worden geïnstalleerd in de directory: C:\Program Files\Smartsite Software\Smartsite Six\ 

 

                                                           
1
 Dezelfde setup wordt gebruikt om een bestaande versie te upgraden naar een hogere versie. 
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 Let op: Het is niet mogelijk de Smartsite setup te de-installeren via Add or Remove programs (De setup is 

geen MSI setup). 

 

De Smartsite iXperion manager componenten worden geïnstalleerd in de Program files\Smartsite 

Software\SmartsiteSix\ directory. 

Laat altijd beiden Installatie opties aangevinkt staan. De License runtime and activator is benodigd om de 

Smartsite iXperion licentie te kunnen activeren. Deze kan eventueel ook geïnstalleerd worden op een aparte 

server
2
. 

                                                           
2
 Indien al een installatie aanwezig is, wordt de mogelijkheid geboden om een backup van de 

bestaande bestanden te maken 
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Na de installatie zijn alle Smartsite CMS componenten geplaatst en geregistreerd. 

 

 

Installatie informatie 

 

De installatie informatie is na de CMS setup terug te vinden in registry key  

” HKEY_LOCAL_MACHINE\SOFTWARE\Smartsite Software\Smartsite” 

 

De publicatie informatie is afhankelijk van de componenten in de WWW\Bin directory van de site. 



 
Elektronicaweg 31  

2628 XG  Delft,  Nederland  
T   +31 (0)15 - 251 37 00  
F   +31 (0)15 - 251 37 01 

 

 
 

Door ing. Silvio Bosch Pagina 41 5-10-2011 

Versie 1.4 

Smartsite iXperion 1.3 Installatie Cursus – (Win 2008 R1 32 Bit) 

7.2 Smartsite iXperion Publication Installatie 

De publicatie installatie bestaat uit twee onderdelen: 

 

1. Installatie van de database 

2. Installatie van de site bestanden en .Net componenten 

 

De Smartsite iXperion publicatie server componenten zijn geschreven in .NET. De Smartsite iXperion .Net 

componenten zijn onderdeel van de website. De .Net componenten hoeven niet te worden geregistreerd in de 

registry. Per site is het in principe mogelijk  een andere versie van de .NET componenten te draaien. Tevens 

dient dan wel de bijbehorende .NET runtime versie hiervan geïnstalleerd  te zijn. 

 

Voor de installatie van de publicatie componenten dienen we de site te plaatsen en daarna de benodigde 

website config bestanden te configureren. Om het configureren van deze XML config bestanden te 

vereenvoudigen heeft Smartsite de Config Editor ontworpen. 

 

Smartsite iXperion 1.3 en hoger ondersteund 2 database versies: 

 SQL Server 

 Oracle 

 

Script SQL Server: 

Voor het aanmaken van een “lege” Smartsite iXperion SQL Server database zijn SQL scripts beschikbaar in:  

“\Sites\EmptySix\Database Creation Scripts\SQL Server” 

 

Script Oracle: 

Voor Oracle is er een SQL+ script aanwezig in Sites\EmptySix\Database Creation Scripts\Oracle. 
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SQLServer: 

Volg onderstaande stappen om de Publicatie site instantie en “empty” SQL database te plaatsen: 

 

1. Creëer op de data schijf (meestal D:\ of E:\) een directory Sites genaamd. (bijvoorbeeld E:\Sites).  

2. Klik met de rechtermuis op het bestand en unzip het bestand Sites\EmptySix\EmptySix_xx.zip naar 

de folder  E:\Sites\Intranet 
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3. In de folder “Sites\EmptySix\Database Creation Scripts\SQL Server” staat een “Create.cmd”  

 

 Let op: gebruik altijd het SQL script dat wordt meegeleverd met Smartsite iXperion 1.3 build-2 of 

later! 

 

Start dit script  en volg de stappen op het scherm om de database te creëren. (De component: 

Microsoft SQL Server Client Tools is hiervoor vereist). 
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Het SQL database creation script vraag om de volgende gegevens: 

 

 De naam van de SQL server (en instance) 

 De naam van de nieuw te creëren database 

 Een gebruiker/password met voldoende rechten om in te loggen op de SQL server en om een 

database te mogen creëren. 

 Het database admin account en password voor de database (standaard 

iXperionAdmin/12345_iXperion) 

 Het database user account en password voor de database (standaard iXperionUser/12345_iXperion) 
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4. In de directory waar de site is uitgepakt: hier  E:\Sites\Intranet\Backup staat het “EmptySix.reg” 

bestand met de default registry instellingen voor de site. Merge deze in de registry. 

 

 

5. Open de registry editor Start >  Run > RegEdit 

Ga naar de key   “HKEY_LOCAL_MACHINE\SOFTWARE\Smartsite Software\Smartsite” en vul het 

SitesRootPath in. Het SitesRootPath is de parent folder van de site, dit geval “E:\Sites\”. 

Let er op dat het pad eindigt op een backslash. 
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6. Selecteer de registry key HKEY_LOCAL_MACHINE\SOFTWARE\Smartsite 

Software\Smartsite\Sites\EmptySix en verander de naam van de key in de projectnaam, in ons 

voorbeeld “Intranet”.  

 

 Let op: Hernoem altijd direct de site(key), anders is het niet mogelijk daarna nog een empty site 

te installeren. Verander in dit geval EmptySix naar Intranet. 

 

HKEY_LOCAL_MACHINE\SOFTWARE\Smartsite Software\Smartsite\Sites\Intranet 

 

7.  Verander tevens de RootPath waarde in de juiste locatie van de site, in dit geval “E:\Sites\Intranet\” 

 Let op: dat het RootPath eindigt op een backslash. 
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 Let op: verander nooit de InstanceID voordat de gehele installatie gereed is. De instanceID wordt 

namelijk op meerdere plekken gedefinieerd (Registry, SmartsiteConfig en Database). 

 

8. Creëer de database connectiestring 

Voordat de publicatie installatie setup kan worden uitgevoerd dient eerst de database connectiestring 

in de  site registry te worden goed gezet. 

Via het Smartsite iXperion 1.x Utilities menu start de Connection Builder 

Klik de Add connection knop 
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Selecteer de “Microsoft OLE DB Provider for SQL Server” en klik Next >>. 

 

Windows Integrated Security connection 

 Let op: In Smartsite iXperion wordt altijd gebruik gemaakt van een SQL account om in te loggen 

in de database. De database wordt niet via Windows Integrated Security benaderd. Het is dus niet 

mogelijk hiervoor een domein service account te  gebruiken.
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Vul de SQL server in met eventueel de instance name. Geef bij het username en password de 

accountgegevens van het iXperionAdmin database account op en vink het Allow Saving password 

vinkje aan. Wanneer de gegevens kloppen kun je de gewenste database selecteren en op de Test 

connection knop klikken. 
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Klik de Copy to clipboard knop om de connectiestring op het clipboard te plaatsen zodat deze in de 

registry kan worden overgenomen. 

 

Plak (CTRL+v) de connectiestring in de registry connectionstring. 

 

De connectiestring dient voor de publicatie zijde tevens te worden opgegeven in de 

Smartsite.Data.config. Dit bestand is terug te vinden in de root van de site, in dit geval 

E:\sites\Intranet\ 
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Smartsite.data.config 

<?xml version="1.0" encoding="utf-8"?> 

<configuration xsi:schemaLocation="http://schemas.microsoft.com/.NetConfiguration/v2.0 

System/Schemas/Configuration/smartsite.data.config.xsd" 

xmlns="http://schemas.microsoft.com/.NetConfiguration/v2.0" 

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"> 

  <smartsite.data> 

     

    <!-- Databases --> 

    <databases> 

      <database id="manager"> 

        <connectionstring>Password=**********;Persist Security Info=True;User 

ID=iXperionAdmin;Initial Catalog=Intranet;Data Source=IXP13-2K-

32BIT\SQLEXPRESS</connectionstring> 

      </database> 

      <database id="Front_End"> 

        <connectionstring>Password=***********;Persist Security Info=True;User 

ID=iXperionUser;Initial Catalog=Intranet;Data Source=IXP13-2K-

32BIT\SQLEXPRESS</connectionstring> 

      </database> 

    </databases> 

     

    <!-- Storage handlers --> 

    <storagehandlers> 

      <handler id="DatabaseStorage" assembly="Smartsite.Data.DatabaseStorage, 

Smartsite.Data" /> 

      <handler id="ThesaurusStorage" assembly="Smartsite.Data.ThesaurusStorage, 

Smartsite.Data" /> 

      <handler id="ContentRelationStorage" 

assembly="Smartsite.Data.ContentRelationStorage, Smartsite.Data" /> 

      <handler id="FileStorage" assembly="Smartsite.Data.FileStorage, Smartsite.Data" 

/> 

      <handler id="FileLinkStorage" assembly="Smartsite.Data.FileLinkStorage, 

Smartsite.Data" /> 

    </storagehandlers> 

     

  </smartsite.data> 

</configuration> 

 

In de Smartsite.Data.config dient voor zowel de manager (CMS) als de front-end (PUB) gebruiker een 

connectiestring te worden gedefinieerd. Iedere connectiestring heeft zijn eigen id. Voor de manager id 

gebruiken we de connectiestring met het iXperionAdmin account, en voor de front-end gebruiken we dezelfde 

connectiestring maar dan met het iXperionUser account. 

 

 Let op: De “Provider=SQLOLEDB.1” parameter dient niet te worden opgegeven bij de connectionstring 

in de Smartsite.Data.config, maar wel in de connectionstring die wordt opgegeven in de site registry. De 

configeditor zal deze parameter sowieso automatisch verwijderen bij opslaan. 
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7.2.1 Publication Update setup 

De Publicatie update setup plaats/update de laatste BIN bestanden in de WWW\Bin directory van de site.  

De Publication Update setup is te vinden op de DVD in:  \Setup\Publication Update. 

 

Tip : Check altijd de Smartsite iXperion site voor de laatste download: 

http://ixperion.smartsite.nl/smartsite.net?id=DOWNLOADS 

 

Via de Publication Update setup is het tevens mogelijk de volgende componenten aan de site toe te voegen: 

 

 SEO Toolkit  (friendly URL’s) 

 Web Toolkit 

 DigiD 

 Ogone 

 Personalisatie 

 Repository 

 Faceted Search 

 SMI 

 

 Let op: deze componenten dienen wel te zijn opgenomen in de Smartsite  iXperion licentie. 

 

Tijdens de setup worden de volgende acties uitgevoerd: 

 

 Creating backup  > Maak een backup van de bestaande site 

 Updating configs > Update de site config xml bestanden 

 Copying Site Files > Kopieer nieuwe site bestanden 

 Copying Site Files for Modules > Kopieer nieuw Module bestanden 

 Deleting Cache Files > Verwijder bestaande cache bestanden 

 Update Site Registry > Werk de registry bij 

 Update Registry Modules > Werk de registry van specifieke Modules bij 

 Performance Counters > Installeer en update de performance counters 

 Updating Start Menu > Werk het Startmenu bij 

 Adding Test Suite...  

 Adding Smartsite Help...  

 Update Database  > Update de database naar de laatste versie 
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Vink de benodigde opties aan en klik daarna op OK. 
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Wanneer de setup wordt uitgevoerd, wordt de mogelijkheid geboden de database automatisch bij te werken tot 

de laatste versie en de geselecteerde modules automatisch toe te voegen. 

 

Selecteer OK om verder  te gaan. 

 

Controleer bovenstaande resultaten log goed en sla deze desnoods op m.b.v. de Copy to Clipboard knop. 
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8 IIS 7 HTTP Server configuratie 

Nu zowel het Smartsite iXperion CMS als de Publicatie site instantie geïnstalleerd zijn, kunnen we in de IIS http 

server de site configuratie uitvoeren. 

1. Start opnieuw de Server Manager  via: 

Windows start menu  >  Administrative Tools > Server Manager 

2. Open Roles > Web Server  (IIS) > Internet Information Server 

3. Voeg in het Connection panel een nieuwe application pool toe met de naam van de site registry key 

(hier intranet). 

 

4. Selecteer Application Pools en selecteer in het optie menu Add Application Pool…. 

 

 

Selecteer bovenstaande settings en typ de naam van de nieuwe application pool.  Klik daarna op OK. 

Tip : Het is een goed gebruik om de naam van de site en applicationpool gelijk te houden aan 

die van de site registry, in dit geval Intranet. 
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5. Selecteer de nieuw aangemaakte Application Pool en klik Advanced Settings 

 

 

6. In het Advanced dialoog kies: 

 Process Model > Idle Time-out: 0 

 

 Kies voor de Identity het Network Service account 
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 Rapid-Fail Protection > Enabled: false 

 

 

 Recycle > No recycle > Regular Time Interal = 0 

Disable Overlapped Recycle  = True (i.v.m. licentie aanpassing) 

Disable Recycling for Configuration Changes = False (i.v.m. web.config aanpassing) 

 

 

7. Maak op dezelfde manier nog een Application pool aan met de naam <SITENAAM>CMS. 

 (Hier IntranetCMS) . Deze application pool wordt gebruikt voor de CMS instantie.  

Dit is een virtuele directory onder de site. De manager zal benaderd worden via http://intranet/cms 

 

 

 Let op: Wanneer gebruik wordt gemaakt van een Domein Service account dient dat bij de Identity 

opgegeven te worden. Om er voor te zorgen dat het domein service account profiel bestaat, dient men 

eenmalig op de server in te loggen met dit service account. 
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8. Maak nu een nieuwe IIS website entry aan  

 

Klik de sites node en kies Add Web Site uit het optie dialoog. 
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 Vul de Site name in. 

 Vul voor het Physical path de WWW folder van de website in (E:\Sites\Intranet\WWW) 

 Kies de juiste application pool. 

 Vul een Hostname in.  

 

 Let op:  De gebruikte Hostname dient aanwezig te zijn in de Domein Name Server (DNS) en te worden 

toegevoegd aan de hostheaders in de registry en in de config editor channels. 

Wanneer de hostname niet in de DNS staat kun je deze tijdelijk in het host bestand op de server zelf opnemen 

(c:\windows\system32\drivers\etc\hosts). 
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Zorg via de Edit Bindings knop in het rechter menu dat de site ook “All unassigned” en/of op IP 

bereikbaar is. (verwijder optioneel de default site) 

 

Klik nieuw aangemaakte site aan en kies uit het optie menu, Add Application. 
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a. Vul voor de Alias in: CMS 

b. Selecteer de CMS Application pool IntranetCMS 

c. Vul ook hier voor het Physical path de WWW folder van de website in 

(E:\Sites\Intranet\WWW) 
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Selecteer de website en dubbelklik het ISAPI Filters icoon 

 



 
Elektronicaweg 31  

2628 XG  Delft,  Nederland  
T   +31 (0)15 - 251 37 00  
F   +31 (0)15 - 251 37 01 

 

 
 

Door ing. Silvio Bosch Pagina 63 5-10-2011 

Versie 1.4 

Smartsite iXperion 1.3 Installatie Cursus – (Win 2008 R1 32 Bit) 

 

Selecteer Add via het properties menu.  

 

 

Voeg het smartsys ISAPI filter toe 

 

 Filtername: Smartsys 

 Executable: C:\Windows\System32\SixSmartsys.dll 
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Het Smartsite ISAPI filter zorgt voor de afhandeling van de hostheaders en de resources (/res) die in 

Smartsite manager worden gebruikt, zoals: plaatje, java scripts,css etc. Het resourcefilter dat gebruikt 

wordt is te vinden in de Smartsite Software registry key:  

 

HKEY_LOCAL_MACHINE\SOFTWARE\Smartsite Software\Smartsite\ResFilters 

 

 

 Let op:  Maak geen gebruik van de IIS manager om de overige settings van de site te 

veranderen. Doordat zowel de website als de /cms application verwijzen naar dezelfde 

WWW root van de site zal IIS proberen in een en dezelfde web.config file te schrijven!  

Wijzigen dienen direct handmatig of via de Smartsite Config Editor te worden doorgevoerd 

in de Web.config. 
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9 Windows Accounts en Folder Permissions 

Windows Accounts 

 

Smartsite iXperion maakt standaard gebruik van een aantal gebruiker accounts. De NT accounts die worden 

aangemaakt worden in Smartsite gekoppeld aan interne accounts (zie Smartsite.Security.config).  De volgende 

standaard accounts dienen op het lokale systeem of op het domein (afhankelijk van implementatie) te worden 

aangemaakt en voorzien van een password. 

 

 iXperion_Admin 

 iXperion_User 

 iXperion_Guest  

 iXperion_Visitor 
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De accounts mogen niet verlopen of gewijzigd worden.  

Selecteer daarom altijd “User cannot change password” en “Password never expires”. 

 

De security permissions en de http Namespaces kunnen vanaf iXperion versie 1.2 automatisch worden 

toegevoegd aan het Windows file systeem en de registry via de Smartsite Config Editor met de actie “Set Site 

Security”. De Set Site Security wizard voegt de aangemaakte account automatisch toe aan de aangemaakte 

groepen en zet de juiste permissions. 
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10 Smartsite iXperion Licentie 

Smartsite iXperion is voorzien van een software beveiligingsmechanisme. Smartsite iXperion maakt daarbij 

gebruik van een HASP licentie server. De licentie service kan op de Smartsite iXperion server worden 

geïnstalleerd (default). Echter is het ook mogelijk deze op een aparte server te plaatsen. Voorwaarden is dat de 

licentie server altijd beschikbaar is, anders zal de site niet starten. 

 

De Smartsite iXperion licentie bestaat uit 3 onderdelen: 

 

1. Het Smartsite.Licensing.config bestand dat in de root van de site (E:\sites\intranet) geplaatst dient te 

worden. 

2. De HASP licentie server (http://localhost:1947) geïnstalleerd door de Smartsite iXperion CMS setup. 

3. Een licentie bestand/key aangeleverd door de Smartsite Helpdesk en ingelezen in de HASP licentie 

manager. 

 

Voor het verstrekken van de licentie zijn de IP gegevens van de server benodigd. Deze zijn op de server op te 

vragen via de Windows command-line (cmd > ipconfig /all). 

 

De licenties kunnen alleen worden opgevraagd bij de Smartsite Helpdesk en dienen tijdig van te voren worden 

aangevraagd. Alleen als alle zaken in orde zijn, zal Smartsite de licentie verschaffen. 

 

De licentie wordt normaliter opgevraagd en geïnstalleerd door de installateur op de dag van installatie. 

 

 

  

http://localhost:1947/
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11 Internet Explorer Temporary Internet Files directory 

Smartsite iXperion maakt gebruik van de Temporary Internet Files directory. Echter ieder account profile in 

Windows gebruikt zijn eigen Internet Temporary Internet Files directory.  

 

 

De standaard locatie om de tijdelijke bestanden op te slaan is: 

C:\Users\USER ACCOUNT\AppData\Local\Microsoft\Windows\Temporary Internet Files 
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Om er voor te zorgen dat de Temporary Internet Files directory onafhankelijk wordt van de gebruiker die inlogt, 

passen we het default path aan naar een specifieke directory voor alle account profile.  

 

Op de data disk maken we een nieuwe directory aan IE genaamd. Deze IE directory is benodigd omdat het niet 

mogelijk is direct Security toe te passen op de “hidden” Temporary Internet Files van Internet Explorer. 

 

Maak de folder D:\sites\IE aan. 

 Start IE en via het menu Tools > Internet Options > Settings knop in het Browse History panel > Move folder.. 
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 Let op:  Na het klikken op Yes zal Windows automatisch uitloggen. 

 

 

 

De Temporary Internet Files directory wanneer hidden en protected folders zichtbaar worden gemaakt. 

 

 

Wanneer we via regedit de registry doorzoeken zien we in de key 

HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Shell Folders de data voor de 

name cache veranderd naar de nieuw opgegeven directory E:\Sites\IE\Temporary Internet Files. 
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Deze waarden dienen we ook te veranderen voor alle accounts die voor het veranderen van de Temporary 

Internet Files zijn ingelogd. 

 

Doorzoek daarvoor de gehele registry op “Temporary Internet Files” en verander de Data voor de name Cache 

voor alle profiles. 

 

 

Selecteer CTRL+F >Selectereer de regsitry root (Computer) >zoek op: 

%USERPROFILE%\AppData\Local\Microsoft\Windows\Temporary Internet Files 

 > selecteer alleen Data > Klik op Find Next. 

 

 

 

 

Verander alle Cache settings in E:\Sites\IE\Temporary Internet Files   
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12 Smartsite iXperion Config Editor 

De Smartsite iXperion Config Editor vereenvoudigt de configuratie van een Smartsite iXperion site en beschikt 

over een validatie mechanisme waardoor voortijdig configuratie-fouten kunnen worden opgespoord en 

opgelost. 

 

De site config bestanden (XML) van een Smartsite iXperion site  zijn te vinden in de root van de site en in de 

WWW van de site. Het aantal config bestanden is mede afhankelijk van de modules die geïnstalleerd zijn. De 

volgende config bestanden zijn aanwezig in de root van de site: 

 

 Smartsite.config 

Bevat alle smartsite specifieke informatie zoals FriendlyName, ServerAddress, ManagerAddress, 

SMTPServerAddress, PublicationInstanceId, Channels etc. 

 Smartsite.Data.config 

Bevat de database connectiestring informatie 

 Smartsite.Security.config 

Bevat de Security, role mapping informatie 

 Smartsite.ImageProcessor.Config 

Bevat configuratie instellingen voor de Image server 

 Smartsite.Licensing.Config 

Bevat de server specifieke licentie informatie 

 Smartsite.ManagementInformation.Config 

Bevat SMI specifieke configuratie instellingen 

 Smartsite.Pdf.Config 

Bevat configuratie instellingen voor de PDF generator 

 WWW\Web.config 

 

Voor alle modules geldt dat deze opgenomen dienen te zijn in de licentie voordat ze kunnen worden 

gebruikt. 

 

De Config Editor pas tevens de gegevens in de site registry aan. 
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1. Installeer de Smartsite iXperion Config Editor door het uitvoeren van de ConfigEditor_x.xx.msi setup in 

de DVD folder Setup\Config Editor. 

 

 

2. Start de Config Editor. Start > All Programs > Smartsite iXperion xx > Config Editor 

3. Selecteer de Site (Intranet) en klik op de knop Validate in de toolbar. 

 

 

We gaan nu stap voor stap de gemelde problemen/instellingen doorlopen. 

 

 Let op: Omdat we tijdens de installatie niet over een DNS server beschikken plaatsen we tijdelijk de 

hostheader in het localhost bestand in C:\WINDOWS\system32\drivers\etc\hosts  
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1. Zorg er voor dat IIS gestart is (IISReset /start). 

2. Start de Smartsite Config Editor via het Windows start menu 

3. Selecteer de Intranet Site Root en klik op de Unlock  knop in de toolbar. 
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Vul alle benodigde gegevens correct in. 

 

 Wijzig de Friendly name 

 Wijzig de Description 

 Selecteer het juiste IISMetaPath 

 Wijzig het Manager Address 

 Wijzig het Test Server Address 

 Wijzig het Site Address 

 

 

 Let op:  Gebruik bij Manager Address, Test Server Address en Site Address altijd het externe adres, 

het adres waarop de site vanaf buiten beschikbaar is. Alle overige adressen toevoegen aan de Channel 

headermappings. 

 

 Let op: De instanceID’s blijven voorlopig gelijk aan EmptySIX.xxx. Deze kunnen pas tijdens de 

outscaling configuratie worden aangepast. 
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Databases 

 

Omdat  we voor de publicatie update de connectiestring in de site regsitry en Smartsite.data.config al goed 

hebben ingevuld behoeven er nu geen instellingen te worden gedaan voor de database. 

 

Geef de iXperionAdmin database inlog een duidelijk herkenbaar ID, manager 

 

 

Geef de iXperionUser database inlog een duidelijk herkenbaar ID, front-end 
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Services - StateSyncService 

Pas het adres aan door de sitenaam opgegeven in de registry site key in te vullen bij het Address. 

 

Opmerking: Net.pipe connecties dienen altijd op localhost te draaien. 

 

InteropService 

Pas het adres aan door de sitenaam opgegeven in de registry site key in te vullen bij het Address. 
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SchemaService

 Pas het adres aan door de hostheader gevolgd door  de sitenaam opgegeven in de registry site key in te vullen 

bij het Address. 

 

EventSynchronisationService 

 Pas het adres aan door de hostheader gevolgd door  de sitenaam opgegeven in de registry site key in te vullen 

bij het Address. 
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ManagerService 

Pas het adres aan door de hostheader gevolgd door  de sitenaam opgegeven in de registry site key in te vullen 

bij het Address. 

 

Security Profiles 

Selecteer voor het Guest, Visitor en User Securityprofile de iXperionUser 
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Selecteer voor het Administrator SecurityProfile de iXperionAdmin 

 

Windows Accounts 

Geef voor alle NT accounts het password in. Deze kunnen logischerwijs niet uit NT worden opgehaald. 
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Channels 

Een nieuwe optie in iXperion 1.2 en hoger is het opgeven van je hostheaders onder de Channels sectie.  

 

Selecteer “Merge database hostheaders” = false, om er voor te zorgen dat de backwards-compability met 

iXperion  1.1 waarbij de hostheaders in de database werden opgeslagen, niet meer wordt gebruikt. 

 

 

 

 

Zorg er bij het aanmaken van de hostheaders voor dat er maar 1 Default is. 

De gegevens worden opgeslagen in de Smartsite.config 
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In de site registry dient een Headermappings key te worden aangemaakt met daarin dezelfde hostheaders 

opgegeven als in de site channels met als aanvulling /cms. 

 

Wanneer er een https:// adres gebruik wordt dient deze te worden toegevoegd. 

 

 Voor http adressen geldt de syntax:   adres/cms 

 Voort https adressen geldt de syntax : https://adres/cms 

 

 

Zie ook hoofdstuk Headermappings 

https://adres/cms
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13 Config Editor foutmeldingen en oplossingen 

Wanneer je na bovenstaande acties klikt op de Validate knop in de Toolbar, dan verschijnen de volgende 

fouten en waarschuwingen: 

 

 

 

1 - Informatie: ACL rights 

Object: Intranet - Smartsite iXperion Intranet Site 

Description: ACL rights 

Error code:  

Message: To validate the ACL rights (filesystem, registry and HTTP namespace security), use the Set Site 

Security utility from the Tools menu. 

 

 

Bovenstaande informatie melding is er voor bedoeld te attenderen op uitvoeren van de  Set Site Security utility. 

En zal ook na het uitvoeren hiervan blijven staan. 

 

 Let op: Smartsite iXperion Set Site Security utility kan alleen juist worden uitgevoerd als de Configuration 

Encryption niet is toegepast! Indien deze niet op none staat pas deze dan eerst aan en sla de configuratie op. 

 

 Let op: Voordat de Smartsite iXperion Set Site Security utility kan worden uitgevoerd dient de huidige 

configuratie te zijn opgeslagen en IIS te zijn gestopt via IISReset /stop. 

 

De Set Site Security utility kan worden gestart via het Tools menu. 
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Laat de optie “Set ACL rules and validate them” geselecteerd staan en klik op Next. 
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Klik op Next. 
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De wizard voegt automatisch bovenstaande NT security groepen toe en wijst daaraan het applicationpool 

account toe. Wijzig eventueel de groepen en klik daarna op Next. 

 

Overzicht aangemaakte NT Security groepen op de server. 
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Klik op Start om de nieuwe security settings toe te passen. 
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Wanneer de validatie compleet is kunnen de details worden bekeken. 

 

 Let op: Smartsite iXperion Set Site Security utility kan alleen juist worden uitgevoerd als de Configuration 

Encryption niet is toegepast!  Het aantal Succeeded Applied rules van rond de 26 is een indicatie dat het zetten 

van de security niet goed is gegaan. Dit dient in de orde van 110 te liggen. 

 

Druk op Close om de dialoog te sluiten (je keert weer terug naar de Config Editor). 

 

 

2 - Warning: Security sensitive configuration settings are not (completely) 

encrypted. 

 

Om dit probleem op te lossen selecteer je de site in de tree. Vervolgens selecteer je een encryptie methode in 

Configuration Encryption voor de Database Connections en Windows Accounts.  

 

DataProtectionConfigurationProvider 

 

Hierdoor worden de passwords in de Webconfig en dataconfig etc. ge-encrypt en zijn passwords niet meer 

leesbaar. 
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De OLE DB database connectionstrings in de Smartsite.Data.config zijn niet meer leesbaar door de encryptie. 

 

3 - Warning: ASP.NET custom error mode sends complete exception details to client. 

This is not recommended for production 

 

Dit probleem is op te lossen door in het View menu Advanced Mode te kiezen. 

Selecteer de site en in het Menu ASP.NET Settings selecteer  Custom Errors Mode.  

Verander deze waarde in RemoteOnly. 

 

Zie http://msdn.microsoft.com/en-us/library/h0hfz6fc.aspx voor meer informatie 

 

 

Klik nogmaals Validate, om de site nogmaals te valideren.  

 

4 – WCF Trace Output File 

 

http://msdn.microsoft.com/en-us/library/h0hfz6fc.aspx
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Object: Intranet - Smartsite iXperion Demo 

Description: Validate site settings 

Error code: SCMS204119 

Message: WCF Trace Output File doesn't use the recommended default path 

E:\Sites\Intranet\LogFiles\WCF 

 

 

Wijzig het pad in de opgegeven waarden. 

 

Druk op Validate om de site nogmaals te valideren. 

 

 

De ACL rights warning zal altijd blijven bestaan. Klik OK. 
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 Let op: Klik eventueel op het save icoon   als deze nog niet “grayed-out” is om de site gegevens op 

te slaan. 
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14 Validate Operational Status 

Om de operationele status van de site te controleren moet de site uiteraard beschikbaar zijn, zorg ervoor dat IIS 

gestart is (iisreset  /start). 

 

Via de knop Validate Operational Status kan worden nagegaan of de sites CMS en PUB goed werken. 

 

Wanneer nu op de knop Validate Operational Status wordt gedrukt, verschijnt de melding dat de site valide is. 

 

 

 

Wanneer er fouten optreden is dit meestal te wijten aan; 

 

1. Een niet geldige of werkende licentie 

2. IIS configuratie (draait IIS) 

3. Foutieve Channel/ DNS configuratie 

4. IE proxyserver instellingen 

 

 

Zet ingeval van fouten de ASP .NET setting Custom Error Mode op van “Remote Only” naar “Off” 

 

Vraag na een IISReset vervolgens via de Internet Explorer de site op via het IP Adres 
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Wees er zeker van dat de site onder IIS op IP bereikbaar is (IIS Bindings). 

 

Een dergelijk melding zal verschijnen: 

 

Om de onderliggende melding zichtbaar te maken dient er achter de URL het default document te worden 

ingetypt in dit geval smartsite.net 
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Plaats het ontbrekende licentie bestand in de root van de site. 
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Nu wordt het werkelijke probleem zichtbaar en kan dit worden opgelost door de juiste licentie te plaatsen en de 

Hasp server bekend te maken via de Hasp license manager. 
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Start de HASP license manager via http://localhost:1947 

Voeg de externe remote license server toe via een “Aggressive Search” en klik op Submit. 

http://localhost:1947/
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Na enige tijd wordt de remote HASP server getoond in het HASP Keys overzicht.  
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Als alles juist geconfigureerd is zal het Smartsite iXperion Empty site scherm verschijnen. 

 



 
Elektronicaweg 31  

2628 XG  Delft,  Nederland  
T   +31 (0)15 - 251 37 00  
F   +31 (0)15 - 251 37 01 

 

 
 

Door ing. Silvio Bosch Pagina 99 5-10-2011 

Versie 1.4 

Smartsite iXperion 1.3 Installatie Cursus – (Win 2008 R1 32 Bit) 

Tip : Om de Smartsite omschrijving van fouten zichtbaar te maken dient de Advanced IE setting  “Show 

friendly HTTP error messages” te worden uitgezet. 

 

 Tools > Internet Options > Advanced (TAB) > Show friendly HTTP error messages 

 

 

 

 

 

De Smartsite iXperion manager kan worden opgevraagd via http://adres/cms (http://192.168.252.7/cms) 

 

http://adres/cms
http://192.168.252.7/cms
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Bovenstaande feedback is alleen zichtbaar wanneer IISStartupFeedback=1 in de “ http” key in de site registry is 

opgenomen. 

 

 

Wanneer de smartsite manager wordt benaderd dan verschijnt de Smartsite logging in het IE scherm. 
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Inloggen op een empty site kan standaard met admin/admin 

 

 

Als alles juist is geconfigureerd zal de Smartsite iXperion manager worden getoond.  
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15 System Panel  

Via de System Panelactie  in de Smartsite iXperion manager kan gecontroleerd worden of Smartsite juist 

geconfigureerd is. Via Smartsys ISAPI filter kunnen de Headermappings worden bekeken > XML 

 

 

Via Publication Server System Information kan gecontroleerd worden of de InteropService juist werkt. 
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16 Internet Explorer Security Zones 

Wanneer een redacteur naar de site surft, dan dient de site URL via domein policies automatisch te zijn 

toegevoegd aan de local intranet of trusted sites zone. Als dit niet het geval is krijg je onderstaande melding in 

je browser. 

 

 

Als het domein nog niet opgenomen is in de DNS dan kun je zelf de URL toevoegen aan je local intranet of 

trusted site zones. 

 

 

In IE > Tools > Selecteer Local Intranet en klik de Sites knop. 
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Klik de Advanced knop. 

 

 

Voeg de URL toe en sluit alles weer af. Klik daarna op F5 om de browser te reloaden. 
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17 Headermappings 

Wanneer de site onder een hostheader komt te draaien en deze is opgenomen in het Domain Name System  

(DNS), kan deze hostheader worden toegevoegd aan de site.  

 

De hostheader moet op verschillende plekken worden gedefinieerd: 

 

 Smartsite.Config 

 IIS Bindings 

 Site Registry 

17.1 Site Smartsite.Config 

Het Smartsite.config bestand is te vinden in de root van de site, hier E:\sites\intranet. 

Zoals te zien is, heeft de Smartsite Config Editor de opgegeven headermappings automatisch toegevoegd via 

de Channel configuratie. 
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17.2 SMTP Server in de Smartsite.config  

 

In de Smartsite.config dient tevens handmatig het de SMTP server te worden opgegeven 

 

 

Doe men dit niet dan zal er in de pagina en de windows evenlogt de volgende melding verschijnen: 

 

Unable to read data from the transport connection: net_io_connectionclosed. 
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17.3 IIS Bindings 

 

Selecteer de website in IIS.Selecteer Bindings in het geheel rechter menu. 

Wanneer niets is opgegeven dan draait de site “all unassigned”, wat wil zeggen dat iedere URL die via de DNS 

verwijst naar het IP adress van de server uitkomt bij de site die draait op de geselecteerde poort. 

Door een hostheader toe te voegen kun je verschillende site onder een andere naam op dezelfde poort 

draaien. Voeg optioneel de hostheader toe in IIS. 

 

 de TCP port op: Default 80  

 De Hostname, hier Intranet 

 En het IP-Adres 

 

 

 

 

IIS Site Bindings met “All Unasigned” en hostheader “Intranet” configuratie. 
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17.4 Site Registry 

 

Open de site registry en maak wanneer deze nog niet aanwezig is, de Headermappings key aan. Voeg onder 

deze key een nieuwe key toe met de hostheader. 

 

 Let op: De Headermappings dienen voor het Smartsite CMS, dus de URL dient te eindigen op /cms 

 

 http:// 

Wanneer er gebruik wordt gemaakt van een http adres dan dient de headermapping zonder http:// te 

worden gedefinieerd. Voorbeeld: intranet/cms 

 https:// 

Wanneer er gebruik wordt gemaakt van een https adres dan dient de headermapping met https:// te 

worden gedefinieerd. Voorbeeld: https://intranet/cms 

 

 Let op: In alle gevallen dient er geen forwardslash '/' te worden toegevoegd aan het einde van de 

headermapping. 

 

Intranet/cms behoeft nu niet te worden opgenomen  in de headermappings omdat het serveraddress 

opgegeven in de site root hieraan gelijk is.  

https://intranet/cms
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18 StateSyncService 

De StateSyncService synchroniseert de state tussen de CMS Server en de Publicatie Server. Omdat deze via 

het outscaling console wordt ingesteld moeten we ook hier de site naam aanpassen. 

Start via de Smartsite manager de Outscaling Console en selecteer Server Instances. Selecteer vervolgens de 

EmptySixPUB server en klik op open. 

 

 

 

Standaard wordt de vertaling %pubinteropserviceaddress% gebruikt. 

 

De %pubinteropserviceaddress% wordt automatisch geresolved naar het juiste adres. 
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Wanneer echter meerdere servers in een outscaling senario aanwezig zijn, kan dit verwarrend zijn wanneer 

gecontroleerd wordt of de servers online zijn. Voor alle PUBS wordt dan aangegeven dat deze online zijn, ook 

voor diegene die normaal niet gevonden kunnen worden (zie hieronder). 

 

Om dit te verkomen kan optioneel deze URL worden aangepast door de juiste site naam (staat in site registry 

key) op te geven en klik op save. 

 

Door via het Outscaling menu in de manager de Server status op te  vragen kan gecontroleerd worden of de 

verbinding tussen CMS en PUB goed werkt. 
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19 Performance library errors voorkomen 

 

Om er voor te zorgen dat er geen onnodige performance library errors optreden in de Windows application 

Eventlog: 

 

o Klik op  Start 

o Klik op Run 

o Typ cmd en klik OK 

o Op de command prompt, typ het volgende commando, en druk op ENTER.  

 

lodctr /T:TermService  of lodctr /R 

 

 

  

20 Klaar 

 

Herstart IIS en bezoek de publicatie en CMS zijde van de site. 

 

http://intranet 

http://intranet/cms 

 

Tip : Voer via de Smartsite iXperion manager een AIM rescan uit en verwijder daarbij alle vorige data. 

Tip :  Herstart de server en controleer de Windows Eventlogs op fouten. 

 

 

 

http://intranet/
http://intranet/cms
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21 Performance Counters 

 

Smartsite iXperion gebruikt performance counters, zodat de Windows Performance monitor de performance 

data kan ontvangen voor ieder Smartsite iXperion onderdeel. 

 

Binnen Smartsite iXperion zijn de volgende performance categorieën gedefinieerd: 

 

 Smartsite iXperion:RenderEngine General 

 Smartsite iXperion:RenderEngine SXML Execution 

 Smarsite iXperion:ImageProcessor 

 Smartsite iXperion:PdfGenerator 

 Smartsite iXperion:ASP.NET 

 Smartsite iXperion:Cache 

 Smartsite iXperion:Database 

 

Daarnaast zijn er een aantal Performance Counter Types gedefinieerd: 

 

 AverageCount 

 AverageTime 

 Count 

 CountsPerSeconds 

 CurrentValue 

 Current number of operations 

 HitRatio 
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Start > Run en typ “perfmon”.  

 

 

Het Windows Performance Monitor scherm. 
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22 SXML Editor 

Om gebruik te kunnen maken van de Smartsite SXML Editor ActiveX control moet op de client deze editor 

worden geïnstalleerd. Denk hierbij aan code-completion, intellisense en validation. Wanneer de Publicatie 

Server start worden alle schema’s omtrent macros en vipers informatie aangemaakt. De SchemaService wordt 

gebruikt voor het aanleveren van deze informatie aan de SXML editor wanneer deze binnen edit item wordt 

gebruikt. 

 

Installeer de Smartsite SXML Editor door het uitvoeren van de SxmlEditor setup. Deze is te vinden in de DVD 

folder Setup\SXML Editor.  

 

 Let op: Voer de setup uit op de client PC’s. 

 

 

Klik op Next > 
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Klik op Next > 

 

Klik op Next > 
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Klik op Close 

 

Wanneer nu een item wordt bewerkt waarbij de editor wordt gebruikt, dan kan gebruik worden gemaakt van 

validatie en intellisense.  

 

 


